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Chapter 10 

Business Rules 
Once data is transformed into information, decisions can be made. Decisions can be based on rules that have 

simple yes or no outcomes or they can be based on relative comparisons. In this chapter, you examine how 

logical rules are written in Excel to evaluate business requirements and analyze data. This includes AND and 

OR functions as well as the logical IF function.  

Why Do I Need to Know This? 

As a college student you learn new things in each class. When you understand the new concepts well enough 

that you internalize the knowledge and are able to apply it to other situations it becomes part of your 

knowledge set—part of what you understand. In the working world, you might be given a job that must be 

done repeatedly such as preparing a monthly report or evaluating people or projects every year. You might be 

assigned a task that requires the same steps be used hundreds of times. In both of these situations, the value 

you add to the process is your knowledge about how to improve the process—how to do repetitive tasks 

faster and more accurately. For repetitive work, it can be worth your time to design a worksheet that applies 

rules to a situation to make the process faster and less prone to error. Your value to your employer goes up 

when you get your work done accurately and quickly. 

1 Rules Based on Logic 

Learning Objectives 
1. Describe the relationship between binary numbers and TRUE and FALSE [10.1.1] 

2. Identify comparison operators and syntax used to determine if a statement is TRUE or FALSE. 

[10.1.2] 

3. Identify functions used to recall and compare dates and their syntax [10.1.3] 

4. Describe the characteristics of a business rule that is easily translated into a formula. [10.1.4] 
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5. Identify methods of combining logical functions to match business rules [10.1.5] 

6. Identify uses for conditional formatting. [10.1.6] 

7. Identify design methods that allow for hiding interim logical steps. [10.1.7] 

Most computers use digital logic that is based on the binary numbering system that uses zeros and ones. This 

type of logic is based on the assumption that a problem can be reduced to simple statements that are either 

true or false. Computers can represent a true statement with a 1 and a false statement with a 0 or with the 

words TRUE and FALSE. 

Comparing numbers 

For example, a business rule may be that a person must be 18 years old to work on an installation crew. In 

Excel, we can setup this problem by placing the person's age in one cell and the required age in another., as 

shown in Figure 10.1. 

 

Figure 10.1. Comparison of applicant’s age to the required age. 

The syntax—rules governing how functions are written— for a comparison is: 

=CellReference, Operator, CellReference 

In this example we use the equals sign at the beginning to indicate a formula or function and then we 

use it as an operator. In a nearby cell the comparison is written, =A2=B2, as shown in Figure 10.2. 
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Figure 10.2. Syntax for writing a comparison using two equals signs. 

In this example, the operator is the equals sign. When the formula is entered, the comparison is 

evaluated as either True or False and one of these words displays in the cell, as shown in Figure 10.3.  

 

Figure 10.3. Because the value in A2 does not equal the value in B2 the result is FALSE. 

If the value in cell A2 is changed from 17 to 18, the comparison is evaluated again and this time it is 

TRUE, as shown in Figure 10.4. 

 

Figure 10.4. Comparison is TRUE. 

If the value for age in cell A2 is changed to 19, the comparison will be FALSE because 19 is not 

equal to 18. This result does not match the intent of the business rule. This is an example of the difference 

between the way we use our language and the simplicity of a computer that uses logic based on zeros and 

ones. When we speak to each other, we assume a certain amount of experience, which is known as world 

knowledge. We all know from experience that an age requirement normally includes the people who are 

older but not those who are younger. A computer doesn't know this; therefore, you must be very careful when 

you write your business rules. The operators used in previous chapters for comparing numbers can be used to 

write business rules. Examples of those comparison operators in logic statements involving cells A2 and B2 

are shown in the table in Figure 10.5. 
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Figure 10.5. Comparison operators used in logic statements. 

If each of the comparison operators shown in the table in Figure 10.5 is entered into the worksheet, 

they are evaluated as shown in Figure 10.6. 

 

Figure 10.6. Evaluation of six comparison operators. 

It is extraordinarily difficult to teach a computer enough world knowledge so that it can interpret what 

people really mean by most statements. Therefore, when writing a business rule, it is best to use words and 

phrases that can be easily translated into a simple computer statement. The easiest rules to translate correctly 

are those that parallel the structure of the comparison. For example, here are five ways that someone might 

state the rule regarding the age requirement. The person must be: 

a. 18 

b. 18 or older 

c. at least 18 

d. cannot be under 18 

e. the minimum legal age 

 

Example b is the best choice because it is most like the comparison greater than or equal to, >=.  
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Comparing Dates 

Recall that dates are stored in the computer as sequential numbers that grow larger by 1 with the passage of 

each day. Therefore, more recent dates are larger than dates from farther back in the past. Personal computers 

have an internal clock that is set using the operating system’s control panel. The current date and time from 

the computer's clock can be used in Excel using the TODAY or NOW functions. These two functions do not 

need arguments but the syntax of functions requires the use of parentheses so these functions use a pair of 

parentheses with nothing between them, as shown in Figure 10.7. 

 

Figure 10.7. NOW function displays current date and time. 

To find the difference in days between two dates, simply subtract one cell reference from the other. 

Determining the number of whole months or years between two dates is more difficult. To find the number of 

months or years between two dates, the DATEDIF function can be used. The DATEDIF function has three 

arguments, =DATEDIF(EarlyDate,RecentDate, period) where the values for the period can be “d”, “m”, or 

“y” to indicate day, month or year. The quotation marks are required, as shown in Figure 10.8. 

 

Figure 10.8.  The "y" argument is used to find the number of years between two dates. 

Observe that this person is almost 18 but the DATEDIF function does not round up so it is useful for 
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rules that have minimum time requirements. 

Comparing Words 

Recall that each character is assigned a number according to the ASCII or UTF standard. The letters of the 

English alphabet are numbered in sequence to make it easier to sort and alphabetize words. If you compare 

two words, the computer first compares the value of the first letter in each word and then proceeds to 

compare the letters in pairs sequentially. Consequently, words compare in the same manner you would use to 

alphabetize them in a dictionary. For example, any word that starts with the letter A is considered less than 

any word that starts with B regardless of the length of the word; e.g. Daylight is less than Night. 

Computers assign different numbers to the upper and lower case versions of the same letter. The 

capital A has a different number assigned to it than the lower case a. In some computer programs, this is an 

important difference and words will sort or compare differently based on whether they have upper or lower 

case letters. Excel is programmed to compare words as if the capitalization doesn't matter, as shown in Figure 

10.9. 

 

Figure 10.9. Comparison of words depends on letter at left. 

A word can be used in a comparison formula if it is enclosed in quotation marks, as shown in Figure 

10.10. 
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Figure 10.10. Words may be used within comparison formulas. 

If the quotation marks are omitted, the Excel program will assume that the term is the name for a 

range of cells. If no such name has been defined, the #NAME error displays. 

Comparing Logical Statements 

Excel reserves the words TRUE and FALSE for use as the result of a logical comparison or function. If the 

word True is typed into a cell, it is automatically converted to TRUE and False is automatically converted to 

FALSE. Consequently, you don't enclose the words TRUE or FALSE in quotation marks if you want to use 

them in a logic statement. If you try to use either word inside of quotation marks to make a comparison, the 

result is FALSE because they do not match. 

Some business rules require that something is not true or not false. For example, you might ask if a 

person has ever had their drivers license suspended. The syntax of the NOT function is; 

=NOT(CellReference) where the cell reference contains a TRUE or FALSE value, as shown in Figure 10.11. 

 

Figure 10.11. NOT function reverses TRUE and FALSE. 

The NOT function returns the opposite of its argument. For example, =NOT(TRUE) is FALSE and 

=NOT(FALSE) is TRUE. 
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AND and OR Functions 

The AND and OR functions use the same logic in Excel as they do in database queries. The AND function is 

TRUE if all of its argument statements are TRUE and the OR function is true if any of its arguments are 

TRUE. The syntax of the two functions are: 

=AND(argument1, argument2, argument3,…) 

=OR(argument1, argument2, argument3,…) 

Observe that the arguments come after the function instead of on either side of it the way they would 

be arranged in a sentence. The list of arguments can be a range of cells that contain TRUE or FALSE 

statements. For example, consider a set of business rules that apply to hiring a member of an installation crew 

that will install solar panels. The applicant must meet each of these conditions: 

a) 18 years old 

b) Valid driver’s license 

c) No record of driving under the influence of drugs including alcohol 

d) Five years of experience or a degree plus two years of experience 

Each rule needs to be stated using language that is conveniently translated into TRUE statements for a 

qualified person, as shown in Figure 10.12.  

 

Figure 10.12. Write business rules that will be true for a qualified candidate. 

The applicant information can be entered into a row followed by the logical formulas. The columns 
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containing the formulas can be hidden later, as shown in Figure 10.13. 

 

Figure 10.13. Design of worksheet so evaluations can be hidden. 

Questions that are designed to be true or false are often answered yes or no instead. Both options can 

be valid if the formulas are designed for it. A validation list can be used to restrict the inputs to TRUE, 

FALSE, YES, or NO as shown in Figure 10.14. 

 

Figure 10.14. Validation lists limit answers. 

To determine if the applicant is at least eighteen years old, the DATEDIF function can be used as an 

argument, as shown in Figure 10.15. Observe that the absolute reference to cell B3 is used so this formula 

can be copied for use with other candidates and that the TODAY() function is used as an argument of the 

DATEDIF function. 
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Figure 10.15. Formula in cell G11 confirms minimum age. 

Because an acceptable answer for the driver’s license question can be TRUE or YES, the OR function 

is used, as shown in Figure 10.16. In the Formula, observe that YES is in quote marks, but TRUE is not 

because it is a logical operator. 

 

Figure 10.16. OR function used to check for TRUE or YES. 

The question about a record of driving under the influence of drugs or alcohol is worded so that a 

candidate will answer YES or TRUE if they have a DUI. The logic statement in column I is written to 

evaluate the DUI answer and return a TRUE response for a qualified candidate. To qualify, the candidate's 

response should be NO or FALSE (they do not have a DUI record) and the logical statement in column I 

converts this answer to TRUE to indicate the candidate is qualified as shown in Figure 10.17. 
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Figure 10.17. FALSE or NO answer is TRUE. 

The rule about experience and education is more complex. There are two ways to meet the 

requirement so the OR function is used: five years experience or a combination of education and experience. 

Each requirement is an argument of the OR function. One of the conditions has two parts that are both 

required so the AND function is used: 2 years of experience and a degree. The answer to the question of a 

degree could be YES or TRUE as shown in Figure 10.18. 

 

Figure 10.18. Nesting multiple criteria for experience and education. 

The first part of the argument evaluates if the person has five years of experience, the second part, 

beginning with AND, evaluates if they have two or more years of experience and a college degree, which 

could be answered YES or TRUE. 

If all four conditions listed in cells G3:B8 are TRUE then the candidate is qualified. The AND 

function is true if the other functions are all TRUE, as shown in Figure 10.19. 
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Figure 10.19. AND function is true if the candidate meets all four requirements. 

The formula could also be written =AND(G11:J11). The formulas can be filled downward to use with 

as many candidates as necessary, because the formulas were designed with absolute references where 

needed. The columns with the logic can be hidden to simplify the form, as shown in Figure 10.20. 

 

Figure 10.20. Business rules applied to several candidates and columns hidden. 

Conditional Formatting 

When there are many rows of similar numbers or words, it can be difficult to visually separate the significant 

values from the rest. Different colors or fonts can be applied to cells that contain values that meet certain 

criteria. In this example, if we had fifty candidates, one of the qualified people might be overlooked. 

Formatting cells based on whether their content meets criteria is called conditional formatting. There are 
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several options on the Conditional Formatting menu as shown in Figure 10.21. 

 

Figure 10.21. Conditional formatting options. 

In this case, a rule can be created that changes the fill color and font to shades of red if the content of 

the cell is TRUE. The result makes it much easier to identify the qualifying candidates, as shown in Figure 

10.22. 

 

Figure 10.22. Conditional formatting  highlights cells that meet criteria. 

Key Takeaways 
 Computers store words and numbers using the binary numbering system, which uses only two 

numerals, zero and one. Logic conditions are similarly binary, where one represents TRUE and zero 

represents FALSE [10.1.1] 
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 Content of cells are compared using the syntax =cellref=cellref. Other comparison operators that are 

used with numbers such as <, <=, >=, >, <> may be used in place of the = sign between the cell 

references:  [10.1.2] 

 The TODAY() and NOW() functions recall the date and date plus time from the computer’s clock. 

The DATEDIF function will determine the number of days, months, or years between two dates. 

The TODAY function can be used as an argument in the DATEDIF function. [10.1.3] 

 Business rules should be written so they parallel the construction of a formula using phrases like 

greater than or equal to to match the comparison operators. [10.1.4] 

 Use the OR function if any of several conditions are sufficient to be TRUE. Use the AND function 

if all of the conditions must be TRUE. [10.1.5] 

 Conditional formatting is used to draw attention to cells that meet criteria for the purpose of 

assisting the user to locate important results. [10.1.6] 

 Instead of combining all of the logical steps in long nested functions, they can be separated into 

individual cells. This makes it easier to troubleshoot the steps of the logical rule. Chose the 

placement of other elements such as titles so that they will not be affected if the rows or columns 

with interim steps are hidden. [10.1.7] 

2 Logical Actions 

Learning Objectives 
1. Describe the use of an energy audit to focus action. [10.2.1] 

2. Identify the arguments and uses of an IF function. [10.2.2] 

3. Identify arguments and uses for conditional sum and count functions. [10.2.3] 

Logical functions can be used to assist in making choices for action. If the data does not exist, the first step is 

to gather it. Making a list of energy consuming devices and their characteristics for the purpose of analysis is 

called an energy audit. In general, if data does not exist, the user can create the data by careful and systematic 

observation and measurement. 

For example a homeowner made a list of the types of lighting devices used in his home and listed the 
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data in a table, as shown in Figure 10.23. 

 

Figure 10.23. Energy use by lighting devices. 

A formula is used in column G to multiply the wattage in column E by the hours per day in column F 

to find the energy use in Watt∙hours. 

The homeowner is advised that incandescent lights are much less efficient than alternatives such as 

traditional straight fluorescent tubes, spiral compact fluorescent lamps (CFL), or light emitting diodes (LED) 

and the best return on an investment in more efficient lighting will come from replacing lamps that are used 

at least four hours a day. CFLs are coiled fluorescent tubes that can replace light bulbs and LEDs are like 

transistors that emit light. 

The IF function 

He decides to include a column with an alert that will display a message on each row of the audit if the lamp 

type is incandescent (I) and the hours of operation are greater or equal to four. 

The IF function has three arguments and its syntax is: 

=IF(condition, action if TRUE, action if FALSE) 

The condition can be any comparison that results in a conclusion of TRUE or FALSE. The actions 

can be formulas, logical statements, or words within quotation marks. In this example, the homeowner 



   

 

16 | P a g e  

 

chooses to display the phrase Consider CFL or LED if the condition is TRUE and no statement if the 

condition is false. As shown in Figure 10.24, the following IF function is written in cell H4 to evaluate the 

lamp type in column B and the hours per day in column F: 

=IF(AND(B4="I",F4>=4),"Consider CFL or LED", "") 

 

 

Figure 10.24. IF function used to display a phrase or nothing. 

In this example, the condition uses a nested AND function that has two arguments. To make the AND 

statement true, the value in cell B4 must be the letter I. Observe that words or letters must be enclosed in 

quotation marks so they are not confused with cell references. To print a phrase as the result of an IF 

statement, the phrase is used as one of the arguments enclosed within quotation marks. To display nothing if 

the result of the condition is false, two quotation marks are used next to each other with nothing between 

them as the third argument of the IF function.  

In row 4, the lamps use incandescent bulbs but they are on less than four hours so the result of the 

AND function is FALSE. The third argument is chosen and nothing is displayed in cell H4. When this 

function is filled downward in column H, the rows where the condition is true, display the message in the 

first argument, as shown in Figure 10.25. 
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Figure 10.25. IF function used to display a phrase where conditions are met. 

The COUNTIF and SUMIF functions 

Summarizing the values in a table by category is a very useful step in analyzing data. The COUNTIF 

function can be used to count the number of times a word or phrase occurs in a range of cells. The syntax for 

the COUNTIF function is: 

=COUNTIF(range, word or phrase in quotes) 

For example, if the homeowner wanted to count the number of times the word Chandelier occurred in 

column C, a COUNTIF function at the bottom of the column could be used, as shown in Figure 10.26. 

 

Figure 10.26. COUNTIF function used to count the number of times a word occurs. 

The SUMIF function is very useful for creating summary tables. The syntax of the SUMIF function 
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is: 

=SUMIF(range,criteria,sumrange) 

The first argument refers to the range of cells to be evaluated, the second argument is the logical 

function that can be TRUE or FALSE, the third argument is the range of cells that contain the numbers to be 

summed if the condition is true. Using range names in place of cell references make it easier to understand 

the arguments. The criteria can be a word or phrase in quotes or a logical function. For example, a SUMIF 

function can be used to find the total watt∙hours of energy use for the CFL lamps, as shown in Figure 10.27. 

  

Figure 10.27. SUMIF function used to sum the energy use by type of lamp. 

The first argument identified the range to be evaluated—named Type, the second argument identified 

the cells in the Type column that contained the value in cell J4 (CFL), and the third argument then summed 

the energy in column G where the Type was equal to CFL.  The arguments can be edited so the function can 

be filled downward to create a summary table. The two ranges can be named or absolute references used so 

they do not change when filled, and the criteria changed to refer to the cell to the left, as shown in Figure 

10.28. 
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Figure 10.28. SUMIF function used to create a summary table. 

Summary tables can be charted to assist in recognizing patterns and relationships. For example, the 

summary table showing the energy used per type of lamp could be displayed as a pie chart with percentages, 

as shown in Figure 10.29. 

 

Figure 10.29. Data from energy audit shows that more than two-thirds of the lighting energy 

is still used in incandescent lamps. 

This type of analysis shows where opportunities for improvement exist, and helps the homeowner 
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make decisions about purchasing lamps or utilizing lighting energy. 

Key Takeaways 
 An energy audit is an examination of how energy is used. It usually consists of a list of appliances, lights, or 

other devices that use energy along with their rate of energy consumption and hours of operation. [10.1.1] 

 An IF function has three arguments. The first is a condition that evaluates as either TRUE or FALSE. The 

next argument is an action that is taken if the condition is TRUE and the third argument is an action to be 

taken if the condition is FALSE. The action can be another IF statement, formula, or text to be displayed. 

Text must be enclosed within quotation marks. [10.2.2] 

 The COUNTIF function has two arguments. The first is a range of cells to examine and the second is text or 

a number to use for comparison. The COUNTIF function returns a count of the number of cells that match 

the content of the second argument. The SUMIF function has three arguments. The first is a range of cells to 

be evaluated, the second is a number or text used for comparison, and the third is a range of cells that contain 

numbers to be summed if the condition is met. The SUMIF function only sums the values from the rows 

where the condition is met. [10.2.3] 

3 Applying Logic in an Energy Audit 

Learning Objectives 
1. Read residential electric and gas meters. [10.3.1] 

2. Use conditional formulas and conditional formatting as analysis tools. [10.3.2] 

3. Adjust heating comparisons for confounding factors of outdoor temperature using heating 

degree days using the SUMIF function. [10.3.3] 

4. Apply date formats and functions such as DATEDIF to find average energy use per day. 

[10.3.4] 

5. Evaluate complex formulas step-by-step. [10.3.5] 

An energy audit is an example of a process that can be done repeatedly where accuracy is important. The 

skills you apply in this exercise can be transferred to many other situations where rules and formulas are 
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applied repeatedly to similar situations. 

An energy audit begins with gathering data. It includes a list of energy consuming devices, their 

power ratings, their hours of operation, and their locations. Items that cycle on and off such as refrigerators 

are more difficult to estimate and can be measured individually with small plug-in meters, such as the one 

shown in Figure 10.30. 

 

Figure 10.30.Plug-in electricity use monitor. 

 A history of energy use is obtained from utility bills or from direct observation of the electric and gas 

meters such as the electric and gas meters shown in Figure 10.31.  
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Figure 10.31. Residential electric and gas meters. 

The meters have parts that rotate as electricity or gas passes through them. Newer meters have digital 

displays but older models have dials. For meters with dials, the spinning part is connected to the first gear in 

a row of small gears whose teeth interlock. For each full rotation of the first gear the next gear moves one-

tenth of a revolution and the same relationship is true for each successive gear. In this manner, the rotation of 

the part within the meter can be expressed as multiples of ten. To reduce the number of parts and make the 

meters cheaper to manufacture, the gears rotate in opposite directions and so do the pointers connected to 

them. To read the dials, assume the pointers on the dials represent a four or five digit number. When the 

pointer is between two numbers on the dial, use the smaller of the two even if it is almost to the higher 

number. If it is between 9 and 0, think of the 0 as ten and use the 9. To determine how much energy has been 

used, read the meter at two different times, and then subtract the previous reading from the present reading, 

as shown in Figure 10.32. 
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Figure 10.32. Reading electric and gas meters. 

Being able to translate the meter display into quantitative numbers allows the resident to experiment 

with energy saving strategies at intervals that are convenient and shorter than a month. The home or business 

owner could determine the energy used for a day under typical circumstances and then try using less energy 

the next day. By reading the meters before and after each time period, the electric and gas energy used during 

both days could be determined and the effect of the strategy determined.  

Tip: Meters used on larger buildings are often set up to measure a portion of the total flow. If 
the front of the meter has a notation such as X10 it means that the meter measures one-tenth 
of the total and the meter reading should be multiplied by 10 to get the total quantity. 

Determining Energy Used from Electric Meter Readings 

In the following exercise, you will determine the  kWh used based on three meter readings to determine if the 

energy use increased or decreased. If the intervals between meter readings are a day or so and they are not 

taken at the same time of day, the date and time should be recorded. Recall that time is stored as a decimal 

fraction of a day in personal computers. 

1. Start Excel. Navigate to the location of files for this class, and then open Ch10Rules.xlsx and then save 

the file as Ch10RulesStudentName using your own name in place of StudentName. 

2. In Ch10RulesStudentName workbook, click the Electric sheet tab.  In cell B2 type =Today( ) and press 

Enter. This function displays the current date. 

3. Select cells A6:A8. On the Home tab, in the Number group, click the Number Format list arrow and at 
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the bottom of the list click More Number Formats. The Format Cells dialog box displays with the 

Number tab selected. 

4. Under Category click Date, and then scroll the list and click to select the Date/Time format shown in 

Figure 10.33 and then click OK. 

Figure 10.33. Date and time format selected. 

5. In cell A6, type 12/2/10 8:00 AM. In cell A7, type 12/3/10 11:00 AM, and in cell A8, type 12/4/10 8:00 

AM. 

6. Examine the three rows of meters below in Figure 10.34. The first row is the meter reading for 12/2, the 

second row for 12/3 and the third row for 12/4. Using the rules described in the introduction, enter the 

three meter readings in cells B6:B8 for the three dates. 
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Figure 10.34. Meter displays for three dates. 

7. In cell C7, write a formula to determine the difference in the first two meter readings: =B7-B6 and fill it 

to cell C8. If the meter readings in cells B7:B8 are correct, the differences will be 31 and 23. 

8. In D7 write a formula to determine the difference in amount of time for the first two days:  =A7-A6 and 

fill it down to cell D8 

9. In E7 write a formula to determine the number of kWh used each day by dividing the meter difference by 

the difference in the days: =C7/D7. Fill this down to cell E8. 

10. Select cells D7:E8 and format them with two decimals. 

11. Click cell F8. On the Formulas tab, in the Function Library group, click the Logical button and then click 

IF to display the Function dialog box for the IF function. Recall that there are three arguments in the IF 

function: a logical test that is evaluated as true or false, what to do if it is true, what to do if it is false.  

12. In the Logical_test box type E8<E7, in the Value_if_true box type "Decrease", in the Value_if_false box 

type "Increase".  Compare your screen with Figure 10.35. This conditional statement indicates if the 

usage increased or decreased from one day to the next. 
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Figure 10.35. Conditional statement to determine if the kWh use was less. 

13. Click OK. With cell F8 selected, on the Home tab, in the Styles group, click the Conditional Formatting 

button. Point to Highlight Cell Rules, and then click Equal To.  

14. In the Equal To dialog box type Decrease, in the with box, click the arrow and then click Green Fill with 

Dark Green Text. Click OK and this conditional format is applied to cell F8. If the previous steps are 

done correctly, the word Decrease displays in green font with a green background in cell F8. 

Compare Heat Energy Use from One Season to the Next Using Heating Degree Days 

Recall that the results of studies can be invalid if there are confounding varaibles that are not taken into 

account. When we try to evaluate the effectiveness of a strategy to reduce energy use for heating, it is 

necessary to consider the outside air temperature. If it was not the same for both periods of time that are 

being considered, the difference must be taken into account. This is accomplished by using heating degree 

days. The heating degrees for one day are found by taking the average of the high and low temperature for 

the day and subracting from the outdoor temperature at which the heating system normally comes on, which 

is assumed to be 65 degrees F.  
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Tip: In most homes, the heat from electrical appliances, incoming sunlight, and human 
metabolism is enough to heat the home on mild days and the heating system does not come on 
until the outside temperature drops below 65 degrees. If you set your home to thermostat to 65 
degrees, the heating system would come on at a lower outdoor temperature so a lower 
reference temperature of about 60 degrees would be appropriate. 

For example, if the high is 50 and the low is 30, the average is 40 degrees. For that day, the heating degrees 

are 25 (65-40). The weather bureau keeps a record of heating degrees for each day of the year for each 

weather station in the country.  A list of heating degrees for the past three years is available as a data file in 

csv format from online sites such as degreedays.net, as shown in Figure 10.36. (BizEE 2010) 

 

Figure 10.36. Source of heating degree days data. 

The file, in comma separated values (csv) format, can be imported into a worksheet in Excel and used 
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to account for the difference in outdoor temperature when calculating the natural gas used per heating degree.  

The SUMIF function can be used to find the sum of heating degrees between two dates. Recall that 

the SUMIF function has three arguments: the first argument is the range of cells to be considered, the second 

argument is a condition that is evaluated as TRUE or FALSE, and the third argument is the range of cells that 

are summed for those cells where the condition is TRUE. When working with the SUMIF function, the 

comparison criteria used in the second argument must be written carefully according to the syntax rules 

shown in the table in Figure 10.37. 

Type of Comparison Syntax Example 

Comparison operator with a number "operator number" "<300" 

Match a number number 300 

Comparison operator with a date "operator"&cellref "<"&B10 

Match text "text" "Melons" 

Comparison operator with text "operator text" "< Melons" 

Match null or empty cells "" "" 

Figure 10.37. Syntax for SUMIF criteria. 

The SUMIF function does not allow nesting of other functions as criteria and there is no BETWEEN 

option. To find the sum of heating degrees between two dates, the difference between two SUMIF functions 

is used.  

Tip: Because there is no BETWEEN function in Excel, a workaround must be devised. To find the 
values between two numbers, you sum all the values equal to or less than the maximum value 
and then sum all of the values that are less than the minimum value. If you subtract them you 
get the difference between the two values including both values. 

1. Click the HDD sheet tab. On the Formula Bar, click in the Name box, type A9:A1109 and then press 

Enter to select the range of dates. Click the Name Box, type WeatherDates and then press Enter. 

2. Repeat this process to name the range B9:B1109 as HDD. Click the Name box list arrow and confirm that 
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WeatherDates and HDD are listed as named ranges. 

3. Click the NatGas sheet tab. In cell C6 type =B6-B5 to calculate the amount of natural gas measured in 

CCF that was used between January 5, 2008 and February 1, 2008. 

4. In cell D6 type =DATEDIF(A5,A6,"d") and then press Enter. 

Tip: The DATEDIF function is an Excel function that finds the number of days, months, or years 
between two dates. It is not officially documented in the Excel manual or help files. This is a 
valuable tool that Excel "insiders" know about. The first argument is the earlier date, the second 
argument is the later date, and the third argument is either "d" for day, "m" for month, or "y" 
for year.  The d, m, or y in the third argument must be inside quote marks. 

5. In cell E6, write a formula to calculate the average CCF use per day by dividing the consumption in cell 

C6 by the days in cell D6. Format the results to display two decimals. 

6. Click cell F6. On the Formulas tab, in the Function Library group, click the Math & Trig button and then 

click SUMIF. In the SUMIF Function Arguments dialog box, in the Range box type WeatherDates, in the 

Criteria box type  "<="&A6, and in the Sum_Range box type HDD. Compare your results with Figure 

10.38. 

 

Figure 10.38. The SUMIF arguments to find and sum the heating degree days from the HDD 
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worksheet. 

7. The results show as 3201. This is the sum of heating degrees prior to the date in A6 including the degree 

days on that day (<=). Click OK. 

8. With cell F6 as the active cell, in the Formula bar, click at the end of the formula and edit the formula so 

it reads =SUMIF(WeatherDates,"<="&A6,HDD)-SUMIF(WeatherDates,"<"&A5,HDD). Check to be 

sure you used a minus sign between HDD)-SUMIF(. The second SUMIF statement uses the less than 

operator to find the dates that are prior to the date in cell A5—1/5/2008. By subtracting this value from 

the first SUMIF calculation, the number of degree days between the two dates, including the degree days 

on both days, is found. The result is 1039. 

9. Press Enter. Click cell F6. On the Formulas tab, in the Formula Auditing group, click the Evaluate 

Formula button.  

Tip: The Evaluate Formula dialog box can be used to analyze a formula or to diagnose problems 
with a formula. When you click the Evaluate button in this dialog box, it steps through each of 
the arguments in the formula and displays the solution to each part of the formula. 

10. In the Evaluate Formula dialog box, click the Evaluate button; the first argument of the SUMIF identifies 

the cell range.  Click the Evaluate button again to analyze the second argument in the formula. Continue 

clicking the Evaluate button until the dialog box looks like the one in Figure 10.39. 
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Figure 10.39. The Evaluate dialog box analyzes the two SUMIF formulas. 

11. Click Evaluate one more time and then click Close. 

12. In cell G6 write a formula to calculate the Average use per HDD by dividing the Consumption in cell C6 

by the heating degree days in cell F6. Format cell G6 to display two decimal places. 

13. Copy the formulas in C6:G6 to C10:G10 

Tip: By using relative references to the dates and readings in columns A and B in combination 
with range names for the weather dates and HDD, the complex formulas do not have to be 
rewritten which improves accuracy. 

14. Click cell G10. On the Home tab, in the Styles group, click the Conditional Formatting button. Point to 

Highlight Cell Rules, and then click Less Than.  

15. In the Less Than dialog box, in the first box type G6. Press Tab and change the format to Green Fill with 

Dark Green Text, and then click OK.  

16. Observe that the average use of natural gas is more in January of 2009 (13.19 vs. 11.11) but it was much 

colder as indicated by the heating degrees (1356 vs. 1039). When adjusted for the colder weather, the 

average natural gas use per heating degree was reduced (.25 vs. .29). Compare your results with Figure 

10.40. 
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Figure 10.40. Energy used was less when adjusted for heating degree days. 

Key Takeaways 
 The dials on a gas or electric meter represent numerals in a number. The number represents the 

quantity of gas or electricity that has passed through the meter. When the pointer is between two 

numbers, use the lower value. If it is between 0 and 9, think of the zero as 10. [10.3.1] 

 The IF function has three arguments. The first is the criterion and it is a combination of cell 

references and comparison operators. The second argument is what formula, function, or display to 

use if the criterion is TRUE, the third argument is what to do if the criterion is FALSE. Conditional 

formatting can be applied using dialog boxes found on the Home tab in the Styles group. [10.3.2] 

 Heating degrees are calculated each day by taking the average of the high and low temperature for 

the day and subtracting that average from the outdoor temperature at which the heating system 

comes on, which is typically 65 degrees. The sum of the heating degrees for the days equal to or 

prior to a given date minus the sum of the heating degrees prior to an earlier date yields the degree 

days between the dates. The comparison operator <= is used for the later date and < is used for the 

earlier date to be sure to include the heating degrees on the two dates. [10.3.3] 

 The DATEDIF function determines the days, months, or years between two dates even if the dates 

span a change in month, year, or leap year. The first two arguments are the later date and the 

earlier date. The third argument is "d", "m", or "y" to indicate days, months, or years between the 

two dates. [10.3.4] 

 Complex formulas can be evaluated a step at a time by using the Evaluate Formula dialog box 

found on the Formulas tab in the Formula Auditing group. [10.3.5] 
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4 Applying Business Rules 

Learning Objectives 
1. Identify at least two companies that provide business credit ratings and two types of rating 

reports they provide. [10.4.1] 

2. Translate business rules into phrases that correspond well with comparison operators and 

logic functions. [10.4.2] 

3. Isolate variables for use in business rules. [10.4.3] 

4. Convert business rules phrases into logical formulas for making business decisions. 

[10.4.4] 

5. Protect worksheets or hide columns to prevent accidental overwrites. [10.4.5] 

Businesses have policies that are used to guide decisions. Those policies can be translated into logical 

statements that combine comparison operators with logical functions so that a worksheet can be used to 

facilitate comparisons and evaluation of options. 

Using Financial Ratings in Business Rules 

Before a business commits itself into a relationship with another business, the managers want to be sure the 

other company can fulfill its agreements in a timely manner. One way to check on the financial health of a 

company and how it behaves towards its creditors is to get a credit report on the company. Industry leaders in 

the credit reporting business are: (Highbeam Business 2010) 

 Equifax 

 Experian Information Solutions (formerly TRW) 

 Moody's Investor Services 

 Dun & Bradstreet (D&B) 

 Trans Union LLC 

A common task within companies is to choose between bidders on contracts. Before the bids are evaluated 

and compared, the companies that are submitting the bids are evaluated to determine if they can deliver on 

the contract if it is awarded to them. If this is a new relationship, the company might obtain a credit report. 

Typical reports include information on how much credit they have available, how far behind they are on 
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paying their debtors, and an estimate of the liklihood of failure in the next twelve months. Figure 10.41 is a 

sample report from Equifax. (Equifax 2010) 

 

Figure 10.41.Sample reports from Equifax. 
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 Developing industries, such as alternative energy, often have many companies that will not be in 

business for more than two years; therefore, it is important to choose partners carefully. Similarly, it is 

important for a company to manage its finances and debt payments to keep its own scores high enough to 

qualify for partnerships.  

The first step is to develop a policy to determine what companies are qualified to bid on contracts. For 

example, the policy might be: 

Bidders that have received at least three contracts must have an average rating of 90% or higher for 

their performance on the last three contracts. Bidders that have received fewer than three previous contracts 

must have an Equifax payment score of at least 80 and a business failure score above 1340.  

In the next worksheet, you will develop business rules to determine which companies are qualified to 

compete for contracts.  You will begin by rewording the preceding policy statement into separate parts. 

1. In Ch10RulesStudentName workbook, click the Bidders sheet tab.  

2. The first rule is really two rules, either of which is sufficient, begin by stating this fact with the word or in 

the sentence. In cell B3, type Bidders must qualify under rule 1 or rule 2.  

3. The first rule uses the phrase Bidders that have received at least three contracts. Anticipate the use of the 

COUNT function and the >= operator. In A4, type 1) Bidders have a count of previous contracts greater 

than or equal to three 

4. The next phrase in the first rule is must have an average rating of 90% or higher for their performance 

on the last three contracts. Anticipate the use of the AVERAGE function and the >= comparison 

operator. Edit the text in cell A4 by adding AND have an average of evaluation ratings greater than or 

equal to 90% on the three most recent contracts. 

5. The first phrase in the second rule is Bidders that have received fewer than three previous contracts. 

Anticipate the use of the COUNT function and the < operator. In cell A5, type 2) Bidders have a count of 

previous contracts  less than three 
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6. The next phrase in the second rule is must have an Equifax payment score of at least 80. Anticipate the 

use of the >= comparison operator. This rule requires the world knowledge that higher scores are better to 

interpret the words at least. In cell A5, append the phrase by adding AND have an Equifax payment score 

greater than or equal to 80 

7. The last phrase is joined to the previous phrase with the word and which does not need translation. The 

last phrase is a business failure score above 1340. Anticipate the use of the > operator. In cell A5, append 

the phrase by adding and a failure score greater than 1340. 

8. The next step is to create rules that will be tested with the data from each applicant. Click cell A6. Notice 

that cell A6:D6 have been merged together. Type Payment score >= press tab and in cell E6, type 80 

9. In A7, type Failure score > and then in E7 type 1340 

10. In A8, type Average contract rating >= and then in E8 type 90 Compare your worksheet with Figure 

10.42. 

 

Figure 10.42.Rules written on the worksheet using comparison operators. 

To translate the phrases of the rules into formulas, use a separate cell for each phrase. Work from left 

to right within the rule and then combine the results of the rules with AND or OR logic at the end. Next you 
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translate the statements using functions and logical if statements to test if each bidder qualifies based on the 

rules. 

11. In cell G11, type =COUNT(B11:D11)  This formula counts the number of contracts for the vendor listed 

in row 11. The result should be 3. 

12. In cell H11, type =IF(G11>=3,TRUE,FALSE)  This formula determines if the number in cell G11 is 

greater than or equal to 3. If it is the results displays TRUE, if not the results display FALSE. The result 

should be TRUE. 

13. Click cell I11. On the Formulas tab, in the Function Library group, click the Logical button and then click 

IF. Click the Logical_Test box and then click cell H11. The test determines if this cell is true. 

14. In the Value_if_true box, type AVERAGE(B11:D11), and in the Value_if_False box type "". Compare 

your dialog box with Figure 10.43. 

 

Figure 10.43. If there have been three previous contracts, the average is calculated. 

15. Click OK. Format cell I11 to display one decimal place. 

16. Click cell J11 and display the IF Function Argument dialog box again. In the Logical_test box type 

AND(H11,I11>=$E$8), in the Value_if_true box type TRUE, and in the Value_if_false box type FALSE. 

Examine the dialog box. This IF statement tests if both H11 is true—there are 3 or more contracts— and 
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the rating is higher than the minimum rating in cell E8. If both conditions are true, then TRUE will 

display, if either one is not true, then FALSE will display. An absolute cell reference to the required value 

in cell E8 is used so this function can be filled down the column. For the first bidder, they have enough 

contracts, but their rating is not high enough so they do not qualify under the first rule. 

17. Click OK. Click cell K11 and display the IF Function Argument dialog box again. In the Logical_test box 

type AND(E11>=$E$6,F11>$E$7), in the Value_if_true box type TRUE, in the Value_if_false box type 

FALSE. Examine the dialog box. This IF statement tests the second rule: does the bidder meet the 

financial ratings. The Payment rating in cell E11 must be greater than or equal to the value in cell E6, and 

the value in cell F11 must be greater than the value in cell E7. If both conditions are true, then TRUE will 

display, if either one is not true, then FALSE will display. Absolute cell references to the required values 

are used so this function can be filled down the column. Compare your dialog box to Figure 10.44. 

 

Figure 10.44. If statement to test if both financial ratings have been met. 

18. Click OK. Click cell L11 and display the IF Function Argument dialog box again. In the Logical_test box 

type AND(G11<3,K11), in the Value_if_true box type TRUE, in the Value_if_false box type FALSE. 

Examine the dialog box, and then click OK. This tests if the contractor would qualify as a new bidder: 

they have less than 3 contracts, and meet the financial requirements. 
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19. In cell M11, type  =OR(J11,L11). This statement returns TRUE if the contractor qualifies under the first 

rule—cell J11—or the second rule—cell L11.  

20. Select cells G11:M11. Point to the fill handle in the corner of cell M11 and fill down to row 17. 

21. Notice that there are green triangles in the corner of some of the cells in column G and column I. Click 

cell G12, point to the Error Checking button  and read the ScreenTip that displays. Click the Error 

Checking button and from the list of options click Ignore Error, which hides the green triangle. Repeat 

this for other cells that display a green triangle. 

Tip: The green triangles are Error Flags used to warn you that there may be an error in a formula and 
the Error Checking button displays an explanation of the suspected error. When you click the Error 
Checking button a list of options display; you can ignore the error, get help with the error, or get a 
more detailed explanation. In this case, there is no error. The adjacent numbers should not be 
included in the formula. 

22. Select cells M11:M17. On the Home tab, in the Styles group click the Conditional Formatting button. 

Point to Highlight Cell Rules and then click Equal To. In the Equal To box type TRUE, in the with box, 

click the list arrow and then click Custom Format. 

23. In the displayed Format Cells dialog box, be sure the Font tab is displayed. In the Font Style box click 

Bold. Click the Fill tab. Under Background Color, in the last row, click the third color from the left—

Orange, then click OK. Click OK in the Equal to dialog box. This creates a custom conditional format 

and cell M13, M14 and M16 display this special format because the bidders in these rows qualify under 

the rules that were tested. 

24. Compare your worksheet to Figure 10.45. If the results in column M do not match, chose one of the 

results that does not match, and then work the logic backward to find the error. 
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Figure 10.45. Three qualified bidders. 

Protecting a Worksheet 

To create a template that might be used by other people in the company to evaluate bidders, it might be a 

good idea to prevent them from accidentally overwriting the complex formulas in columns G through L. One 

method is to protect the cells to prevent accidental changes and the other is to hide the columns that contain 

them. 

1. Select cells A4:A5, hold down the Ctrl key and select cells E6:E8, and A11:F17. These are the cells that 

can be changed. Compare your screen with Figure 10.46.  
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Figure 10.46. Cells that can be changed are selected so they can be unlocked. 

2. On the Home tab, in the Cells group, click the Format button. At the end of the list click Format cells. In 

the dialog box that displays, click the Protection tab, and then click to remove the check mark next to 

Locked. These cells are no longer locked into the same protection condition as the rest of the worksheet. 

Click OK. 

3. On the Review tab, in the Changes group click the Protect worksheet button. The Protect Sheet dialog 

box displays as shown in Figure 10.47. You can protect a worksheet with or without a password. 
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Figure 10.47. Protect Sheet dialog box is used to protect a worksheet from changes. 

4. Do not type a password. Click OK and notice that the name under the Protect Sheet button has changed to 

Unprotect Sheet. 

5. Click in any cell where the formulas are located—G11:M17 and attempt to change a formula. A message 

displays to warn you that the cell you selected is protected and therefore read-only. Click OK to close the 

message. 

6. Click the Unprotect Sheet button to remove the protection. 

7. Select columns G:L, right-click on one of the selected column headings and then click Hide. 

8. On the Review tab, in the Changes group, click the Protect Sheet button. In the Protect Sheet dialog box, 

click OK. The interim steps are hidden and the worksheet is protected except for the unlocked cells, as 

shown in Figure 10.48. 



   

 

43 | P a g e  

 

 

Figure 10.48. Interim steps hidden and formulas protected. 

9. You now have a tool that will allow you to evaluate bidders quickly, consistently, and accurately. Save 

your work. 

Key Takeaways 
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 Several companies provide ratings of the financial health of businesses. Two of the largest are 

D&B (Dun and Bradstreet) and Equifax. They provide similar reports that rate how they pay their 

bills and an estimate of the likelihood that they will go out of business in the next twelve months.  

[10.4.1] 

 If a rule is really two or more separate rules label them separately. Identify phrases that can be 

replaced by phrases that match the structure of comparison operators. For example, replace at least 

with greater than or equal to. [10.4.2] 

 Identify specific numbers within the rules that might be used in formulas or changed in later rule 

revisions. Place those numbers in their own cells. [10.4.3] 

 Use a separate cell for evaluating phrases in the rules and then combine them will logic statements 

in other cells. This practice makes it easier to troubleshoot the rules. [10.4.4] 

 Unlock the cells that are supposed to be changed and then protect the worksheet to prevent changes 

to the cells that are still locked. Alternatively, hide the columns that have the intervening steps. 

[10.4.5] 

Key Terms 

Compact Fluorescent Lamps 

Fluorescent lamps that are coiled to make them small enough to replace light bulbs. 

Conditional formatting 

Ability to change the format of a cell based on the evaluation of a criteria. 

Energy audit 

Detailed list of energy consuming devices that usually consists of a description, location, power rating, and 

hours of operation. 

Heating degrees 

For each day, the average of the high and low temperature is subtracted from a reference temperature at 

which the heating system activates—usually 65 degrees. The difference is the heating degrees for that 

day. 

Light Emitting Diodes (LED) 

Transistor-like devices that emit light. 

Syntax 

Rules that govern how functions are written 



   

 

45 | P a g e  

 

World knowledge 

Collection of facts and contexts of a wide range of topics. 
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